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1 Information on the Current Version and 

History 

1.1 Version 01.93 (June 2016) 

New Functionality 

● NorDig Cable (R&S BTC-KT3325) supported. 

● Basic Receiver Test (R&S VT-KT3380) supported 

1.2 Version 01.92.4 (Apr 2016) 

New Functionality 

● NorDig Satellite (R&S BTC-KT3326) supported. 

1.3 Version 01.92.3 (Jan 2016) 

New Functionality 

● DTMB Terrestrial (R&S BTC-KT3330) supported. 

● AVBRun AV DISTORTION TE1 (R&S VT-KT3360) supported. 

● HDMI CTS source test (R&S VT-KT3357) 

- VT-B2363 Support 

●  HDMI CTS sink test (R&S VT-KT3356) 

- VT-B2363 Support 

 

 

1.4 Version 01.91 (Sep 2015) 

New Functionality 

● E-Book Test Suite (R&S BTC-KT3312) supported. 

● AVBRun Camera Support (R&S BTC-KT3329) supported 

● HDMI CTS source test(Elec.) (R&S VT-KT3358) 

● D-Book Test Suite (R&S BTC-KT3310) 

- Add AVBRun Camera Support  



R&S AVBrun Information on the Current Version and History 
 

 
 

 

 
Release Notes 2115.7200.00 -  4 

1.5 Version 01.90 (June 2015) 

New Functionality 

● NorDig T/T2 RF Test Suite (R&S BTC-KT3311) supported 

● Thailand Profile (R&S BTC-KT3332) supported. 

● Vietnam Profile (R&S BTC-KT3333) supported 

● HDMI CTS sink test (R&S VT-KT3356)  

─ Additional 6G test cases supported 

● HDMI CTS source test (R&S VT-KT3357) 

─ Additional 6G test cases supported 

 

Fixed Issues 

● VTx version: 

─ In VTx1.90, EDID control issue is solved. 

● Result report – HDMI CTS sink test (R&S VT-KT3356): 

─ For HF2-6 6G-Scrambling test, When the result is passed, it returns correct 

comment which is “Sink DUT adequately supports format”. 

1.6 Version 01.82 (Feb 2015) 

New Functionality 

● HDMI CTS sink test (R&S VT-KT3356)  

─ 6G test cases supported 

● HDMI CTS source test (R&S VT-KT3357) 

─ 6G test cases supported 

Known Issues 

● VTx version: 

─ HDMI CTS source test (R&S VT-KT3357) doesn’t work properly with VTx 

1.80 because of EDID control issue. 

● Result report – HDMI CTS sink test (R&S VT-KT3356): 

─ For HF2-6 6G-Scrambling test, When the result is passed, it returns wrong 

comment which is “Sink DUT does not adequately support format. It will be 

changed to “Sink DUT adequately supports format”. 

1.7 Version 01.80 (Jan 2015) 

New Functionality 

● D-Book Test Suite (R&S BTC-KT3310) supported. 
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1.8 Version 01.70 (Sep 2014) 

New Functionality 

● HDMI CTS sink test (R&S VT-KT3356) supported. 

● AV distortion test (R&S VT-KT3360) 

─ Audio measurement supported  

1.9 Version 01.60 (May 2014) 

New Functionality 

● HDMI CTS source test (R&S VT-KT3357) supported. 

 

1.10 Version 01.40 (September 2013) 

New Functionality 

● D-Book test suite (R&S BTC-KT3310) supported. 

1.11 Version 01.32 (August 2013) 

New Functionality 

● Support for MHL CTS 1.3 added. 

1.12 Version 01.30 (June 2013) 

New Functionality 

● AV distortion test (R&S VT-KT3360) supported. 

Fixed Issues 

● "Remote License Server" dialog:  

─ Messages show the current communication state. 

─ Available licenses on the remote instrument are listed. 

1.13 Version 01.20 (March 2013) 

New Functionality 

● MHL CTS 2.0 sink and dongle test supported. 

● MHL CTS 2.0 source test supported. 
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● R&S AVBrun remoting now supports more than one client GUI. Each client gets a 

client ID. This gives more flexibility to programmers to visualize the different 

clients properly. The R&S AVBrun included test clients uses different colors for 

instances <= 2 and closes the R&S AVBrun main program only if the last client 

instance is closing. 

● Measurement report: Cover page lists "Total Test Time" and "Weighted Test 

Time". Weighted Test Time is the same as total, unless the test plan contains the 

new test steps "TestTimerHalt" and "TestTimerContinue". 

● "Report" test module ("Elements" folder): 

─ "AbortOnFailure" changes the "Abort test plan on 1st failure ("Early Fail")" 

default setting from measurement report. This way, sections of a test plan 

can be included or excluded from "Early Fail". 

─ "ReportComment" writes out a user defined headline and textline to the 

measurement report. 

─ "ReportVerdict" requests the current overall measurement report verdict and 

provides a P/F value in an output parameter. 

● "TestTimerHalt" test module ("Elements" folder) halts the test timer until the 

"TestTimerContinue" test step in a test plan. This allows to exclude certain 

sections of a test plan from the weighted test time measurement. If the timer stays 

halted until test plan end, that entire section is excluded from the time 

measurement. 

● "TestTimerContinue" test module ("Elements" folder) resumes the test timer and 

includes the following test steps for the weighted test time measurement. 

Modified Functionality 

● In the "Tests" tab, the DLLs are not shown by default. You can enable this view by 

a new "DLL View" button. 

● In the main window status bar, the new entry "Connected Clients" is shown if at 

least one client is connect. This view is updated when the mouse is moved over 

the status bar. If you try to close the R&S AVBrun using the "x" in the header or 

"Exit" in the "File" menu and if there are still clients connected, you will be 

prompted and can make a choice to revise the exit. 

● SCPI connection: New functions for buffered read. Details for developers can be 

found in the appropriate documents. 

● User prompts pop up on the appropriate parent client window, except message 

boxes (will be added later). 

● The SCPI report can be configured to suppress any SCPI log file dump. 

● Simple GUI remoting server probes a port list: 8080, 55669, 51778, 58127. This 

avoids port conflicts with local HTTP servers. "Simple GUI" remote clients can 

connect automatically as long as at least one of the probed ports is available. 

● Measurement report: Own directory for TXT file export. Added option to text file 

export to store either in default directory or use a separate directory for TXT only. 

● "BasicInitializing" test module ("Elements" folder): 

─ Reset only for the addressed subinstrument. 

─ New property to suppress the instrument option list in the measurement 

report cover. 
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Fixed Issues 

● If you entered the "&" character into the property user interface of 

"\Tests\Installed\Elements\Report\DUTInfo", this caused invalid XML reports. 

● Remote access to instrument and license requests from either remote instruments 

or local AVBPC dongles does now work on Windows XP installations that have 

not installed the latest security updates (Windows update). 

Note: The Visual Studio 2005 redistributable package is installed prior to the 

R&S AVBrun installation. Do not abort this installation because this is an update. 

● Simple GUI:  

─ R&S AVBrun Test Client 2 showed PASS on Early fail condition. 

─ Made test clients work for Windows 7 64-bit. 

● Measurement report: Result section still showed passed even if "Abort" occured. 

● Serial port: Fixed cleanup "Null Reference" exception. 

● Installer now creates DUT_DB folder. 

Known Issues 

● Measurement report: 

─ With large amount of data (especially trace data), it takes some time to create 

the report files. In these cases, it needs some time until the "Test Plan 

Finished" state is reached even though the test sequence is already finished. 

─ PDF export in landscape format inserts some additional blank pages if 

printing a lot of diagrams to the report (but all diagrams are still visible). 

─ New data tags export: CSV and XML export do not consider all new data tags 

yet. Diagram data is not yet exported to text files. Report filter (i.e. only failed 

tests) are not yet working for TXT export. 

─ If a newly created test plan has syntactical error, R&S AVBrun will hang after 

clicking "Run".  

1.14 Version 01.10 (October 2012) 

   

 
 R&S AVBrun test DLLs distributed for version 01.00 will not work with this release. 

   

New Functionality 

● Measurement report: 

─ New file name options: 

<Serial No.>[_<Auto Increment>] 

<P/F Prefix>_<Serial No.> *** OVERWRITE EXISTING*** 

<P/F Prefix>_<Serial No.>[_<Auto Increment>] 

─ Save only passed tests added to save options. 

─ New text export capability and various options to shorten the exported text 

file. TXT export logs the test time. 
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─ Shows R&S AVBrun version in report header (can be disabled) for PDF, TXT, 

XML, CSV. 

─ New report data tags: 

Serial number type (i.e. IMEI, MEID, MAC Adr.) 

Serial number format (hex or dec) 

Additonal user editable DUT info data that appears in the report header (i.e. 

customer, codes, etc.) 

Test setup / profile info tags 

─ Failure code settings: "Resources" > "Measurement Report" > "Fail Options" 

tab: 

Enable failure codes 

Default codes for pass/fail 

Result sections 

─ Result sections allows to define result sections. For each section, an overall 

pass/fail annex is listed in the report. 

─ Automatic print of exported TXT files on user selectable condition (always, if 

pass/fail). 

Font selection / page size for txt printout: "Resources" > "Measurement 

Report" > "Print" tab 

For getting as many character into one line, modify "Resources" > 

"Measurement Report" > "File Options" tab > "File Export" tab > "Txt 

Options..." > "Max. Line Length". 

● Simple GUI to select & run test plans. No desktop link installed yet, start 

AVBrunTestClient.exe from the R&S AVBrun bin directory (requires HTTP 

port 8080 connection). 

● "Parallel Testing" test module ("Elements" folder): 

─ With two concurrent test plans. The report of the parallel (slave) can be 

merged into the master test plan (incl. result section & failure codes (but no 

diagrams yet). The slave test plan can optionally aborted by master, if master 

"early fails". 

─ "StartTestPlan": Loads and starts a secondary test plan in a new tab. 

─ "WaitForTestPlan": Waits for the secondary test plan to finish. 

● "Report" test module ("Elements" folder): 

─ "ReportDutInfo": Adds user configurable DUT model and additional DUT info 

to the report header. 

─ "ReportTestProfile": Adds user configurable test profile test setup info to the 

report. 

─ "ReportFailureCode": Pushes a failure code onto the measurement report 

stack. This code will be assigned to all subsequent test items until a new 

code is assigned. The last failure code is displayed in the measurement 

report summary. 

─ "ResultSection": Defines a user configurable result section. For each section, 

an overall pass/fail annex will be listed in the report. 

─ "Comment": Writes a user defined headline and text to the report. 

Modified Functionality 

● A "Restart AVBrun" message box opens after changing the license server to avoid 

confusion about not found licenses. 
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● Copy&paste for test plan items/subtrees now also works between two editor 

windows using drag&drop or the context menu. 

Fixed Issues 

● Measurement report: 

─ "Parallel Testing Report Merge" caused endless merge loop if "Abort Slave 

Test Plan on Master Early Fail Condition" was selected. 

─ Data rows missing in XML export file, if item context is listed after data rows. 

─ "SerialNumber *** Overwrite ***" file name option did not work for CSV and 

TXT exports. New data was appended to those files instead of creating a new 

file. 

─ Fixed manual file export (via buttons): If "Save Report" was "Never", "Only 

Passed" or "Only Failed", the manual export ("-> PDF", "->TXT", etc. buttons) 

only exported the latest test plan data every time and did not consider the 

back/forward browse function. 

─ CSV export fixed for homogeneous columns. 

─ TXT export: Double spacing in TXT tables. 

─ With "Save_Never" or "Save_OnlyFailed" options, the file exports triggered 

from the GUI showed strange table lines. 

─ Pass/fail prefix for file names not working. 

● "FileTransfer" test module ("Elements" folder): Fixed slow file transfer with long 

files. File size is currently limited to 128 Mbyte, some VISA connections may only 

allow 16 Mbyte. 

● Serial device: demo mode not working for "BytesToRead" requests. 

● Sometimes remote license could not be located. 

● R&S AVBrun crashed on Windows user logout or Windows shutdown. 

● R&S AVBrun did not start due to "No Printer installed". 

Known Issues 

● Measurement report: 

─ With large amount of data (especially trace data) it takes some time to create 

the report files. In these cases, it needs some time until the "Test Plan 

Finished" state is reached even though the test sequence is already finished. 

─ Pdf export in landscape format inserts some additional blank pages when 

printing a lot of diagrams to the report (but all diagrams are still visible). 

─ New Data Tags Export: Csv and xml export do not consider all new data tags 

yet. Diagram data is not yet exported to text files. Report filter (i.e. only failed 

tests) are not yet working for txt export 

─ The "File Name" options do only apply for automated file export but not for 

manual export using the "->PDF", "->TXT", etc. buttons. 

1.15 Version 01.00 (May 2012) 

● Initial release. 

● MHL CTS sink test supported. 

● MHL CTS source test supported. 
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2 Modifications to the Documentation 

The current documentation is up-to-date. 
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3 Installation and Update 

The R&S AVBrun software consists of the R&S AVBrun sequencer software itself and 

a basic set of applications and examples.  

In addition, ready-to-run test cases are available as software options. For information 

on available software options refer to the data sheet or brochure of the instrument 

provided on our homepage (www.rohde-schwarz.com). 

3.1 System Requirements 

R&S AVBrun can be installed on a computer or an R&S instrument. For best 

performance, the installation on a computer is recommended. 

Computer 

● 1300 MHz (x86) processor 

● 256 Mbyte free memory space (minimum) 

● 80 Mbyte free hard disk space (minimum) 

● Windows
©
 XP (32-bit edition with SP2) or Windows

©
 7 (32-bit / 64-bit) operating 

system 

● Microsoft .Net Framework version 2.0 SP02 or 3.5 SP01 

You can download these version from the Microsoft download center at 

http://www.microsoft.com/. 

Note: Do not use any other versions as these releases fix some memory and 

performance issues of .NET2.0. .NET 4.0 and later are not used by the 

R&S AVBrun. Even if a .NET 4.x version is installed on your computer, you need 

to install 2.0 SP02 or 3.5 SP01 in addition. 

● Administrator rights for installation 

● LAN connection to communicate with the instrument 

● Suitable firewall configuration for network access 

3.2 Installing the Software 

You can install the R&S AVBrun software and the test cases (software options) in the 

same procedure. 

1. Double-click the setup file. 

2. Accept the license agreement. 

3. Select the components: 

Disable all components you do not want to install. You can install and combine as 

many software options as you like. If you use a smart card as license storage 

device, do not disable "Disable Log On Smart Card (Recommended)". 

4. Click "Install". 

http://www.rohde-schwarz.com/downloads/firmware/vts.html
http://www.microsoft.com/
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5. When the installation is completed, click "Close". 

In the R&S AVBrun browser, on the "Test" tab, in the "Installed" folder, a subfolder 

for each test case (software option) is displayed.  

 

If no valid license key exists, the dll file appears dimmed and is unavailable. 

3.3 Activating the License Key 

To use the test cases (software options), you need to activate the license key. The 

activation procedure depends on your license storage device: 

● Instrument 

● AVBPC smart card 

Activating the license key on a smart card 

1. Insert the smart card into the card reader. 

2. Start R&S AVBrun. 

3. On the "Options" menu, select "License Keys" > "Smart Card". 

4. If you received your license key in the printed "Software Option List": 

a) Click "Install". 

b) Enter the key.  

5. If you received a license key file (rsi): 

a) Click "Install from File". 

b) Select the file and open it. 

c) Select the option (R&S VT-KT<option no.>). 

d) Confirm the license key. 

6. Click "Close". 

7. Restart the R&S AVBrun software to apply the settings. 
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Installing the license key on the instrument 

1. On the instrument, activate the software option as described in the "Installation 

Instructions for Options" delivered with the license key. 

2. Start R&S AVBrun on the instrument or on the computer. 

3. On the "Options" menu, click "License Keys" > "Remote Device". 

4. Enter the "Resource Name" of your instrument.  

5. Click "Access" to check the connection to the instrument and to retrieve 

information about the installed licenses. 

6. Restart R&S AVBrun to apply the settings. 

3.4 Uninstalling the Software 

Depending on your operating system, the procedure may vary: 

1. On the "Start" menu, select "Control Panel". 

2. Under "Programs", select "Uninstall a program". 

3. Right-click "R&S AVBrun" and select "Uninstall". 

3.5 Updating the Software 

New versions of the R&S AVBrun software are installed in addition to the existing 

versions, no upgrade mechanism is provided. You can use several versions on the 

same computer, however only one version can run at a time. If a version is no longer 

required, you can uninstall it. 

Configuration settings are stored individually for each software version, thus the 

versions use different configuration sets for: 

● Global resource settings 

● "Test Plans" and "Tests" folders 

● Resource directory 

● Commands directory 

● Debug mode (single step) 

The R&S AVBrun files created during the tests (test plan, measurement report) are 

assigned to the last installed R&S AVBrun version. You can assign any other installed 

R&S AVBrun version. 

To assign files to another R&S AVBrun version 

Prerequisite: administration rights on your computer 

1. Open the "Version Selector":  

Windows "Start" menu > "Programs" > "R&S AVBrun" > "R&S AVBrun Version 

Selector" 
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2. Under "Other Available Versions", select a version. 

3. Under "Click to Activate Version", enable the version. 
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4 Customer Support 

Technical support – where and when you need it 

For quick, expert help with any Rohde & Schwarz equipment, contact one of our 

Customer Support Centers. A team of highly qualified engineers provides telephone 

support and will work with you to find a solution to your query on any aspect of the 

operation, programming or applications of Rohde & Schwarz equipment. 

Up-to-date information and upgrades 

To keep your instrument up-to-date and to be informed about new application notes 

related to your instrument, please send an e-mail to the Customer Support Center 

stating your instrument and your wish. We will take care that you will get the right 

information. 

Europe, Africa, Middle East 
Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com 

North America 
Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com 

Latin America 
Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com 

Asia/Pacific 
Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com 

China 
Phone +86-800-810-8828 / +86-400-650-5896 
customersupport.china@rohde-schwarz.com 

 

mailto:customersupport@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.china@rohde-schwarz.com

